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Much of Plan‐G is intuitive.  You don’t need this comprehensive manual at all.  So, for those who 

don’t have time to read manuals, but just want to get going, here is a worked example of a short VFR 

flight across some of England’s most beautiful and famous landscapes.  It introduces as many 

features of Plan‐G  that can be reasonably packed into a short 115 mile flight. 

 

 

Figure 103 Carlisle to Liverpool – The Route 

 

16.1  Preparation 

Just as in the real world, there is a significant amount of preparation required before flight.  Of 

course we will start by creating a flight plan in Plan‐G. 

1.  Open Plan‐G and on the Home Tab, click “Find”. 

2.  Select Airport from the dropdown and enter EGNC in the ICAO Code box. 

3.  Carlisle will be highlighted.  Click OK. 

4.  Right‐click the airport icon and select “Start Flight Plan at airport EGNC” 

5.  Now set up the flight conditions.  Open the Home Ribbon by clicking the Home  tab, and then click   

     Altitude, and set 4,000 feet. 



6.  Select Airspeed, and enter 100 knots for the default Cessna 172. 

7.  Now that you have a Start Location, you can now add a Start Position for your aircraft at Carlisle.   

     In FS, you have already selected PARKING 1 ‐ RAMP GA  SMALL, so from the Home Ribbon, select  

     “Start Position”.  From the options  shown in the pop‐up “Set Airport Start Position” window  

     which appears, select  PARKING 1 ‐‐ RAMP GA SMALL again, and click OK. 

 

16.2  The Scenic Route 

 You have established the flight pre‐conditions and now it is time to plot the route to Liverpool. 

1.  Find the Wigton VRP to the south‐west of Carlisle.  Right click and select “Add User Waypoint   

     CARLISLE WIGTON to the plan.  (Wigton is a Visual Reference Point and included in the default  

     Plan‐G database, although it is called a User Waypoint). 

2.  If you do not have photographic scenery for the UK, Wigton (the town) will not be obvious, so you  

     may wish to add a Cross Reference to it from Dean Cross VOR. Right‐click the Wigton VRP symbol  

     and select ‘Set Waypoint Cross References’ 

3.  In the Cross reference window, click ‘Add’ for the first point, and enter “DCS” in the entry box.   

     Select the Dean Cross (the only) entry, and click OK 

4.  Observe the Cross reference red line from Wigton to Dean Cross VOR.  In the plan, note the  

      bearing and distance (231º 8.7 nautical miles).  When you fly the route, you can compare your  

      present bearing and distance from Dean Cross VOR to find which way to fly to arrive overhead  

      Wigton.   

5.  From Wigton, you will fly over Keswick and admire the beauty of the Lake District.  You need to  

     create a User Waypoint for Keswick (pronounced Kezzik, by the way).   You will find Keswick to the  

     south east of Dean Cross, on the south side of Bassenthwaite Lake and just north of Derwentwater 

6.  At zoom level 12, you will see the town clearly.  Right click on the town name Keswick shown on  

     the map, and complete the User Waypoint Dialogue box. Check that “Location” is set as the  

     waypoint type.  Enter Keswick Town in the Name box, and KESWIK in the Identifier box.  In the tag  

     box, you could enter your  initials to indicate that it is one of your user‐created waypoints. 

7.  Click OK and observe the small green waypoint circle appear on the plan.  If it doesn’t show, drag  

     the map a small amount and it will be displayed as the map refreshes.   

8.  Now you can add another leg to the plan.  Right click your new waypoint and Select the option  

     “Add user waypoint KESWIK Keswick Town to the Plan” 

9.  Note that the newly added track line goes over some impressive looking high ground.  It is in fact       

     Skiddaw, at 3,052 feet, the 4 th  highest mountain in England.  If you have downloaded the Digital       

     Elevation Model (DEM) tiles from the NGDC  GLOBE' website at  

     http://www.ngdc.noaa.gov/mgg/topo/gltiles.html  you can now look at what this means in terms  

     of vertical navigation.  (See section 12.3 for details of DEM.)  If you haven’t downloaded the DEM  

     tile for the UK, you really ought to.  It adds a great feature to Plan‐G.  You need tile B, filename  

     b10g.gz  which covers 90% of the UK. 



10. So you now have the DEM info installed.  Open the View Ribbon, by clicking the View tab, and tick  

       the Plan Elevation Tick box at the top left of the ribbon. 

11. Whoa! That is some mountain (in UK terms anyway) 24 nautical miles en route.  Note the  

       Maximum Elevation Figure (MEF).  You will now realise why the planned  altitude was 4,000 feet. 

12. Now zoom the map to Level 14.  The names of the Lakeland peaks are visible at that scale.  Move  

       the cursor and observe the Latitude and Longitude changing on the status bar at the bottom.   

       Find the location which is at Latitude N54º 27’ 15’’ Longitude W003º 12’ 42’’.   You will see the  

       name Scafell Pike – England’s highest mountain at 3,210ft.  Create another user waypoint at the  

       top of the mountain. Call the waypoint Scafell Pike, with the Identifier SCAFLPK.  The elevation of  

       your  waypoint should be 3,100 feet.  If you have the downloaded the DEM files, this value will  

       already be set in the elevation box by Plan‐G. 

 

 

Figure 104 Over the Lakeland Hills 

 

13. Add Scafell Pike to your route, as before.  When you fly this route, alongside  Bassenthwaite Lake,  

       overhead Derwentwater and down the Borrowdale Valley to Scafell Pike, you will find the view  

       hereabouts quite spectacular in default scenery, but with a good mesh and photographic scenery  

       – simply stunning. 

14. You now want to head more west to Ravenglass, Latitude N54º 24.00’ Longitude  W003º 29.00’.   

       But there are some things you need to watch out for.  Open the Map ribbon, and switch on  

       ‘RPDM Airspace’ by clicking in the tickbox.  (RPDM stands for Restricted, Prohibited, Danger,  

       Military, which could be simply  translated “Don’t go there”). 

15. At scale level 12, there is a large orange circle centred on Sellafield, and just south of that, a very  

      large red fan shaped area.  Open the Information Window from  the View menu to see what is  

      known about them.  Click on the edge of the  orange circle.  In the Information Window, you will  

      see “Restricted Area Sellafield  SFC‐2200”.  You cannot overfly one of Britain’s oldest and most  

      famous Nuclear  Power Stations below 2,200 feet. 

16. But note also, that if you move the mouse into the open area a little to the east,  the Information  

      Window shows that you cannot fly above 5,500 feet because  that is the Warton Radar Advisory       

      Service Area.You must contact Warton Radar  for permission to fly up there.  (Warton is an RAF  

      station just south east of Blackpool). 

 



17. The big red area is Eskmeals Danger Area from the surface upwards to the stratosphere (SFC+).   

       Eskmeals is (or was) a naval gun testing range where they  fire(d) big shells out to sea.  Avoid! 

18. It might be a better plan to route direct from Scafell Pike to Barrow and look at nuclear  

      submarines being built!  Pan slowly down from Ravenglass and you will see Barrow (Walney  

      Island) Aerodrome EGNL and two NDBs WL and FN.   Add  Barrow Aerodrome to your route. 

 

 

Figure 105 Sellafield and Eskmeals “Don’t Go There” Areas 

 

16.3  A Little Stick of Blackpool Rock  

 

English comic singer George Formby made this song famous, along with his other risqué songs such  

as “With me little ukulele in me ‘and”.  You are probably not interested in that, but to fly down the 

coast to Blackpool and beyond might be interesting. 

1.  From Barrow, looking south, you have the wide expanse of Morecambe Bay.  The famous  

     comedian Eric Morecambe took his stage name from the place.  When the tide is out, this whole  

     area is devoid of water; when the tide is in, it looks as it does in FS, all water.  The area is  

     treacherous with quicksand, very fast flowing tides and channels so that anyone caught out on the  

     sands on an incoming tide had better get out of there quickly.  It has been the scene of many  

     tragedies.  In Flight Simulator, where ditching in this dangerous area is not a consideration,  

    you might as well plan to go straight across to Fleetwood Golf Course, a Visual Reference Point for  

    Blackpool.  Make sure you have Visual Reference Points (VRPs) enabled on the Map ribbon, so that  

    you can see the small orange circle symbols for VRPs.  Right click on the small orange circle to add  

    Fleetwood to your route.   

2.  Fleetwood was once home to Britain’s second largest fishing fleet after Grimsby, but fishing has  

     declined to near zero and the harbour today is populated by many smart yachts.  If you intend to  



     fly online and by chance Blackpool Approach is on duty, this is where you will make your initial call  

     to them.  “Request transit your Plan G User Manual  V 3-1.061 October 2012 overhead at 4,000  

     feet”.  So you had better add Blackpool EGNH to your Plan now. 

3.  The track line from Fleetwood to Blackpool is over land, but the “Left Hand Rule” for VFR flight  

      states that if you are following a line feature, you should keep it on your left.  This route is well  

      used by light aircraft in the real world, who follow the convention of keeping the shoreline on the  

      left.  Thus southbound traffic flies a mile or so out to sea.  Northbound traffic flies over the land.   

      So although the trackline is over land, when you come to fly the route, you should really do the  

      same, passing a mile or so west of the 08 end of Blackpool’s main runway.  Blackpool Approach  

      will want you to call them at the “the tall tower”.  They don’t say “Blackpool Tower”, as you could  

      well think they mean the building on the aerodrome, not the world famous 518ft high lattice steel  

      structure a couple of miles further north. 

4.  After Blackpool, add Marshside VRP to your route; (you can do this now without help, surely) and  

      then once more follow the coast to Woodvale. 

 

5.  Add Woodvale aerodrome EGOW to your plan.  The airport symbol is red because it is a military  

     (RAF in this case) aerodrome.   The track line is again inland but you will want to fly on the  

     seaward side of the shoreline. 

6.  So why not fly over Birkdale Sands, a beach airstrip which was first used for pleasure flights as  

     long ago as 1919? http://www.seftoncoast.org.uk/articles/01winter_aviation.html  

7.  Right‐click Birkdale Sands airstrip (EGCO) to add it to your plan.  The track line now goes from  

     Marshside VRP to Woodvale then back to Birkdale Sands, a zigzag line which is not what you want.   

     So open the Plan Window from the ‘View’ ribbon and right‐click the new Birkdale Sands entry, and  

     select “Move waypoint up”.  Now Birkdale Sands appears before Woodvale and your route is  

     restored to something sensible. 

8.  Look now about 2.5 miles south of Woodvale.  See the red line running horizontally across the  

     map?  Move the mouse to that line and read the information in the Information Window.  Here  

     you are at 4,000 feet.  Is there something you need to do? 

 

16.4  Controlled Airspace 

You are now getting close to Liverpool and things will change rapidly.  You have planned to enjoy a 

leisurely flight with that great sense of freedom which flying (real or virtual) brings but what you will 

now have to plan for is controlled airspace and procedures.  If you plan to fly on line, you will quite 

possibly have an ATC position manned – someone to talk to and give you instructions.  You should be 

familiar with correct ATC phraseology if you are planning to fly this route on line. 

“Manchester TMA Class A 3500+” you should have read in the Information Window in Section 16.3, 

numbered item 8 above.  TMA stands for “Terminal Manouevring Area, and being Class A Airspace, 

and you are flying VFR, you absolutely cannot go there, so you must plan to descend.    

 

About 6 miles further south again is the Liverpool Control Area (CTA) from 2500‐ 3500ft, with 

beneath it, the Liverpool Control Zone (CTR) which extends from the  surface to 2500 feet.  Both are 



Class D airspace.  You can go there, but only with permission from Air Traffic Control.  Because IFR 

traffic inbound to Liverpool will be brought down to a minimum altitude of 2,500 feet to capture the 

ILS, and required traffic separation is 1,000 feet IFR from VFR in Class D Airspace, you will be given 

the instruction from Liverpool Approach to fly “not above 1,500 feet.”  So you must plan to descend 

from 4,000 to 1,500 feet in 8 miles or so, about 4 minutes.  A quick calculation, tells you that that is 

650 feet a minute – quite a rapid descent in a light aircraft. 

 

 

Figure 106 Controlled Airspace around Liverpool 

 

Figure 106 is a composite graphic showing the complexity of controlled airspace round Liverpool.  

Just south of Woodvale (EGOW) is the Manchester TMA boundary, and an row points to the Seaforth 

VRP.  The other four arrows represent mouse pointer positions.  The four Information Windows are 

shown which you will see if you place the mouse pointer at each of those positions.  Of course in 

Plan‐G you will only see one set of information at a time in your Information Window. 

9.  Fortunately, all you need to know, as a light aircraft pilot inbound to Liverpool, is “Only enter the  

     Liverpool Control Zone (CTR) at Seaforth VRP, and only then when ATC gives permission” and “Not  

     above 1500 feet”.  

10. First, however, complete the next leg of the route. 

11. Find the Seaforth VRP just west of Bootle.  Add Seaforth VRP to your plan.  On a VFR flight, when  

      you first contact ATC at Liverpool just after Woodvale, you will be told “Runway 27 in use, report  

      at Seaforth, not above 1,500 feet”. 

12. Now add Liverpool Airport to the plan.  You now have a complete route airport to airport. 

 

 



 

16.5  Change of Plan 

However, you decide to practice flying the ILS and the procedural approach (called just “the 

procedure” among pilots) rather than the norm of accepting vectors from Air Traffic Control, so that 

changes the ball game completely.  You will now deemed to be flying IFR, and you need the 

Instrument Approach Charts, or “Approach Plates”.  Plan‐ G can save you the trouble looking for 

those approach plates for planning as you will see.  However, this manual isn’t going to tell you how 

to fly the procedure, but just how to complete your plan to landing.  

 

The procedure starts at the LPL NDB, so you can fly direct from Woodvale to the NDB.  

No need to go via Seaforth, which is the VFR route, because you are now flying IFR. 

1.  First, add the LPL NDB to your plan.   

2.  Delete the waypoint “Liverpool‐Seaforth” from your plan, by right‐clicking it’s entry and selecting 

“Delete Waypoint”.  It is no longer relevant. 

 

 

Figure 107 Seaforth VRP Deleted from the Plan 



 

Figure 108 Instrument Approach Procedure 

 

3.  Right‐click on Liverpool Airport, and select “Instrument Approaches”.  Select “ILS 27” from the  

     pop‐up window.   

4.  Click on the transition “2.  LPL” which is the one for Category A aircraft (that’s you in your Cessna),  

     and the procedure is displayed on the map.   

The blue line indicates the approach path on the ILS passing over the LPL NDB.  The red line is the 

missed approach procedure.  It uses tighter radius turns and shorter distances, but is otherwise the 

same as 1.LPL.  If you select 1.LPL temporarily you can see the difference. 

 

16.6  VNAV Profile 

The next task is to create a vertical navigation profile.  You need to get safely over those mountains, 

yet descend in time to get under the Manchester TMA near Woodvale, and then be at 2,500ft on 

reaching the LPL NDB. 

1.  Open the Plan in the Plan Window, and using the horizontal scroll bar if necessary, find the  

     “Passing Alt” Column.  It is reasonable to assume that climbing out of Carlisle at 500 feet per  

     minute in your Cessna 172, that in the 13.9miles to Wigton, you can easily reach 2,500ft.  So  

     double click in the cell on the row CARLISLE‐WIGTON and type in 2500. 

2.  Move down to the Keswick row and double click the cell in the “Passing Alt” column.  To make  

     sure you clear Skiddaw and Scafell Pike, type in 4000. 

3.  In the same way, enter 4000 for Fleetwood Golf Course VRP and Blackpool Airport EGNH. 

4.  Mindful of the Manchester TMA south of Woodvale, with its base at 3500ft, go to the Woodvale  

     row and the “Passing Alt” column, and enter 2500. 

5.  To fly the Liverpool 27 procedure for the ILS, you need to be at the LPL NDB at 2500 feet.  So move  

     down to the LPL row and the “Passing Alt” column, and enter 2500 again. 



When you fly the route, you will get “Top of Descent” alerts a mile before Woodvale, and again a 

mile before reaching the LPL NDB. 

 

16.7  Notes 

You have read in the Flight Plans section (section 14 above) about how to enter notes.  It will be 

important not to forget to descend below the Manchester TMA floor south of Woodvale, and to 

remind yourself that after Wigton, you need to be at 4,000ft. 

1.   Scroll across to the right of the Plan table and in the Notes column for the Keswick Row, double  

      click and enter Continue climb to 4000ft. 

2.  Then do the same for the Woodvale Row, double click and enter Manchester TMA base 3500ft.  

     Remember that passing altitudes, cross references and notes will be printed on your plog, and  

     saved with your plan if you save the file as a .PLG file, but not if you save the file as a .PLN file. 

    

16.8  Alternate 

What if you cannot land at Liverpool?  What if some VATSIM or IVAO newbie is plonked right on the 

runway and is disinclined to move.  You need to add an  “Alternate” to your plan – somewhere you 

can go to if Newbie is still there when you are a mile from touchdown rapidly approaching the 

Missed Approach Point! 

Look around the map, and select somewhere suitable.  RAF Sealand is closed, and anyway it was 

gliders only, Manchester won’t really welcome a slow Cessna 172, but Hawarden, just to the 

southwest of Chester, is G.A. friendly.    

 

Right click on Hawarden and select “Set EGNR as Alternate”.  A red line is now drawn on the map 

from Liverpool.  Hawarden (pronounced “Harden” by the way) was, in VATSIM’s early years, VATSIM 

UK’s busiest airport, with a controller on duty seven nights a week. 

 

 

Figure 109 The Track to the Selected Alternate Airport 



If you need an Airport diagram to find out where E_Parking  11 Ramp_GA_Medium is, (it’s an FS 

parking spot, so won’t be shown on the official CAA Aerodrome Diagram, will it?) right click the 

airport symbol once more, and select ‘Show Airport Diagram’.  This opens the Airport Diagram 

Window and after a second or two loading the data, the airport diagram appears in the window  (See 

Section 12.6 above for more details.)  You can see the G.A. Apron with small blue circles for the 

parking stands. 

 

Figure 110 The Completed Plan 

 

So that is your planned flight, with some local knowledge thrown in to make it more interesting.  In 

fact, if you don’t fly VFR often, you may have discovered that short VFR flights can be just as 

challenging as IFR flight across continents.  When you fly the route, don’t forget to complete the task 

properly by taxiing to Liverpool’s General Aviation apron at the east end of the airport.  Park on stand 

E_Parking  11 Ramp_GA_Medium, shut down and secure the aircraft. 

16.9  Let’s Go Flying 

You have printed out the Plog from Plan‐G so it is time to go flying. 

16.9.1 Microsoft Flight Simulator 

 

Figure 111 Forney Aircoupe G-ARHC Over Derwentwater in FSX 



1.    Open Flight Simulator, and select Free Flight from the Main Menu. 

2.    Set Country as United Kingdom, and select Current Location as Carlisle (EGNC). 

3.    Select Starting position PARKING 1 ‐‐ RAMP GA SMALL. 

4.    Select Aircraft type Cessna 172 

5.    Set a suitable time and date for a daylight VFR flight. 

6.    Click Fly Now.   

7.    When the flight has loaded, save it as the default so that you can easily get back to this position if  

       you need to. 

8.    Find the current weather for Newcastle EGNX (the nearest weather station to  Carlisle) from an  

       Internet Aviation Weather site, such as http://weather.noaa.gov/weather/coded.html . 

9.    Set the Newcastle wind, cloud and precipitation information in FS.   

10.   Alternatively, if you are a member of an online Flightsim community such as  VATSIM or IVAO,  

        simply connect to the service and the weather at Newcastle will  be automatically loaded into FS 

11.   Start up, taxi to the active and enjoy your flight over England’s highest mountains  to England’s  

        second most famous city. 

 

16.9.2 X-Plane 

 

 

Figure 112 Heading towards Derwentwater in X-Plane 9 



1.  Start X‐Plane, and Open Settings/Quick Flight Setup 

2.  Set your Location as Carlisle (EGNC). 

3.  Select Aircraft type Cessna 172. 

4.  Find the current weather for Newcastle EGNX (the nearest weather station to  Carlisle) from an  

     Internet Aviation Weather site, such as http://weather.noaa.gov/weather/coded.html . 

5.  Set the Newcastle wind, cloud and precipitation information in the weather box.   

6.  Alternatively, if you are a member of an online Flightsim community such as VATSIM or IVAO,  

     simply connect to the service with XSquawkbox or X‐IvAp and  the weather at Newcastle will be  

     automatically loaded into X‐Plane. 

7.  Go to Location/Local Map and move your aircraft to the main apron  (if X‐Plane has placed your  

     aircraft in the default position at the center of the runway  intersections) 

8.  Go to Environment/Date & Time Set a suitable time and date for a daylight VFR flight. 

9.  Save the flight to avoid having to reset the many parameters such as QNH, and  weather, and you  

     can easily get back to this position if you need to. 

10. Start up, taxi to the active and enjoy your flight over England’s highest mountains  to England’s   

       second most famous city. 

Note: In X‐Plane non‐hard surfaces are generally best avoided for starting up or parking, as the effect 

of soft ground is exaggerated. 


